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Инструментальные                                  

средства разработки 

для ARM-контроллеров
RealView Microcontroller Development Kit

ULINK2 – адаптер USB/JTAG 

Evaluation Boards – оценочные платы
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Keil an ARM Company

 Ведущий производитель ПО  

для микроконтроллеров

 Компиляторы ANSI C/C++, отладчики

 Моделирование устройств

 Библиотеки и др. компоненты

 База данных по МК

 Содержит >1 200 

8/16/32 bit контроллеров

 Отличная поддержка

 Web портал поддержки 

 Дистрибьюторская сеть

 Большая клиентская база

 100K+ пользователей в мире
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Инструментальные средства для ARM
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Microcontroller Development Kit

 Ведущая технология 

программирования

 Компилятор ARM RealView 

 IDE / отладчик Keil µVision

 Полная поддержка устройств

 ARM7, ARM9, Cortex-M3

 Содержит коды Start-up и алгоритмы Flash

 Полное моделирование устройств

 Board support packages (BSP)

 RTX Real-Time Kernel

 Эффективное ядро RTOS для малых систем

Интегрированная программная среда разработки для ARM 

микроконтроллеров. Проста в обучении и использовании!

RealView Microcontroller 

Development Kit
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µVision Device Database

RTX RTOS Kernel

RealView C/C++ Compiler

µVision Debugger &   

Analysis Tools

Complete Device Simulation
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RealView Real-Time Library

 Соответствует требованиям 
разработчика
 Проектирование встраиваемых систем

 Системы реального времени

 Коммуникационные и сетевые задачи

 Разработана для использования с MCU

 Широкий ряд примеров
 Простое начало работы.

 Используются как стандартные блоки

 Нет дополнительных отчислений -
Royalty Free
 Включает исходный код RTX.

 Одно- и многопользовательские лицензии 

Обширная библиотека готовых к использованию компонентов

Ускоряет разработку программного обеспечения.

RealView

RTX Source Code

TCP/IP Suite

Flash File System

USB Device Interface

CAN Interface E
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Real-Time Library

SIMECS



7

Аппаратные компоненты

Целый ряд оценочных плат и аппаратных отладчиков.

 ULINK2, ULINK-ME – адаптеры 

USB – JTAG 

 Отладка и программирование 

Flash

 Поддержка JTAG и SWD

 Оценочные платы

 Примеры и BSP для популярных 

контроллеров

 ARM7, ARM9 и Cortex-M3

 NXP и ST Micro

SIMECS
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MDK-ARM
Microcontroller Development Kit
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Поддержка конкретного контроллера

 Встроенная поддержка

 Более 490 ARM контроллеров

 Код инициализации 

 Мастер конфигурирования

 Алгоритмы программирования Flash

 Многочисленные примеры

 Включая BSP для популярных плат

 Полная симуляция устройства

 Не только симулятор процессора!

 Моделирует встроенную периферию

 АЦП, ЦАП, таймеры

 UART, CAN, прерывания ..

 Внешние сигналы и входы/выходы

С помощью MDK-ARM можно сразу приступить к разработке ПО, 

без какой-либо аппаратуры и глубоких знаний о контроллере.

SIMECS
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Создание программы

Шаг 1: Выбор устройства и средства 

отладки
Шаг 2: Конфигурация устройства и 

написание кода приложения

µVision включает в себя менеджер 

проектов, редактор и отладчик

Device Database в Интернете & 

µVision облегчает выбор устройства 

и конфигурирование

SIMECS
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Тестирование программы

Загрузка программы на плату и 

окончательная отладка

Отладка при помощи µVision 

Debugger

Шаг 3: Отладка µVision Device Simulation Шаг 4: Окончательная отладка на плате

SIMECS



12

Новые возможности µVision4 IDE

 Ведущая интегрированная среда разработки

 Поддерживает микроконтроллеры ARM, C166, и 8051

 Конфигурирование конечного устройства и база данных 

устройств

 Симуляция

 Инструкции CPU

 Периферии

 Редактор исходных файлов

 Отладка проекта

uV4

SIMECS
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Поддержка нескольких мониторов

 Гибкая система управления окнами

 Поддержка нескольких мониторов

 Размещение окон в произвольном порядке на рабочем 

пространстве

Monitor 1 Monitor 2

SIMECS
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Гибкая система управления окнами

 Возможность открыть несколько окон одного типа

 Окна могут быть размещены в любом месте, даже вне окна 

μVision, например как отдельное окно операционной системы

 Возможность группировать окна

 Облегченный доступ и навигация

SIMECS
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Мастер конфигураций

 Настройка среды под конкретное устройство

 Доступен для всех микроконтроллеров

 Включен в базу данных устройств

 Мастер конфигураций

 Основные параметры устройств

 Изменение параметров в 

диалоговом режиме

SIMECS
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Многопроектное рабочее пространство

 Часто необходимо работать более, чем с одним проектом 

одновременно

 Разработка приложения и загрузчика

 Многоепроектное рабочее пространство

 Определите группу проектов как многопроектный файл (.MPW)

 Работайте с несколькими проектами одновременно

SIMECS



17

Примеры и шаблоны

 Board Support Packages

 Примеры и BSP для большого количества плат от различных 

производителей

 Примеры работы для отладочной платы или симулятора

 Шаблоны

 База для проекта разработчика

 Включены в MDK-ARM и RL-ARM

SIMECS
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MDK-ARM
Compilation Tools

SIMECS



19

Компилятор RealView 

 Компилятор RealView содержит:

 Высоко оптимизированный ISO C/C++ compiler

 Поддерживает ARM, Thumb и Thumb2, в том числе FPU

 Полная поддержка C и C++ run-time library

 Преимущества компилятора RealView

 Код компактнее и быстрее

 RealView Compiler

 Micro Library для малых встраиваемых систем

 В µVision интегрирован Source Browser - отображает  

расположение  всех переменных и функций 

Лучший из компиляторов - увеличивает скорость выполнения 

программы и сокращает стоимость системы.

SIMECS
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 Стандартная библиотека RearView оптимизирована для 

встраиваемых приложений с жесткими требованиями по объему 

памяти

 Минимальные ресурсы для неиспользуемых функций OS

 Неиспользуемые функции удаляются из памяти

 Данные получены на базе теста Dhrystone 2.1 

MicroLib – оптимизированная библиотека

Библиотека MicroLib сокращает размер системного кода на ~50%
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Source Browser — база данных программных 

символов

 Для быстрой навигации по исходному файлу

 Показывает все функции и переменные, определенные в 

исходном коде программы

SIMECS



22

MDK-ARM
Verification and Debug
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µVision – симуляция и управление

 Полная симуляция 

 Быстрая симуляция системы команд

и встроенной периферии
 АЦП, ЦАП, таймеров

 UART, CAN, I2C, прерываний ….

 включая внешние сигналы и I/O

 Управление 

 Полная синхронизация системы 

 Общий останов

 Детальный анализ и полный контроль

 Полный доступ к периферии

Симуляция всех компонентов аппаратной части.

Исполнение кода для устройства в целом.

Device Simulation

D/A

A/D

SRAM

Flash / EEPROM

UART

SPI

Ethernet

Interrupts

GPIO

CAN

USB

Timers

CPU

Extending Simulation

AGSI Interface

Board or System 

Interfaces

Device 

Simulatio

n

External Peripherals
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CPU и управление периферией

 Симуляция всех устройств периферии

 Точки останова для периферии

 Полная остановка системы, включая входные сигналы

 Точки останова и возможность отладки «шаг за шагом»

 Полный анализ системы

 Запуск из определенного места кода

 Отладка в любом состоянии MCU

 Временной анализ при полной остановке процессора

SIMECS
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Окна System Viewer

 Отображает значения регистров периферии устройства

 Подробная информация о состоянии каждого из регистров

 Возможно изменение значений регистров прямо из окна System 

Viewer

 Можно выводить значения 

регистров от одного или нескольких

периферийных устройств

 Во время отладки можно 

открывать несколько окон

SIMECS
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µVision – временная статистика

Симуляция предоставляет дополнительные возможности, не 

достижимые при JTAG отладке.

 Точный временной расчет и

детальный анализ исполнения 

программы при различных 

параметрах

 Гибкий просмотр
 Исходный код

 Полная картина исполнения

 Анализ эффективности кода на 

уровне С и ассемблера. 

 Подробная статистика
 Время исполнения 

 Число обращений

SIMECS
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Анализ плотности кода

 Помогает убедится в том, что все строки кода 

используются в программе

 Часто используется при сертификации

 Выделение цветом

 Пройденные строки

 Пройденные и пропущенные

блоки алгоритма

 Позволяет производить

полную проверку

 Увеличивает плотность

кода

SIMECS
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Анализ выполнения кода

 Анализ выполнения кода «инструкция за инструкцией»

 Детализированная информация о программе

 Сколько раз вызывается каждая строчка кода

 Время выполнения для каждой инструкции

 Анализ производительности кода

SIMECS
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 Анализ временных диаграмм
 Аналоговых и цифровых сигналов

 Внутренних переменных

 Импульсов на входах – выходах

 Сигналов JTAG 

 Синхронизация с исходным кодом

 Точные временные диаграммы
 Используется цветной курсор

 Виден временной отсчет

 Анализ кода

 Отображение в окне анализатора 

 При несанкционированном доступе в память -

останов симуляции 

µVision – логический анализатор

Графический мониторинг аналоговых и цифровых сигналов.

Анализ временных диаграмм одновременно с трассировкой 

кода.

SIMECS
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MDK-ARM
CoreSight Debug and Trace
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Технология Coresight

 Новые режимы отладки и характеристики:

 Standard JTAG – 5-ти проводной интерфейс + дополнительные 
возможности предоставляемые Coresight

 Новый режим Serial Wire (SW) – 2-х проводной интерфейс

 Дополнительные функциональные возможности по сравнению с JTAG

 Serial Wire Viewer (SWV) – 1 дополнительный контакт

 Предлагает Real-Time Trace без дополнительных аппаратных средств

 SW и SWV содержатся в стандартном разъеме JTAG

 Не требуется новый разъем или отладочный адаптер

 Поддерживается в:

 RealView MDK 3.15+ и ULINK2/ULINKME

 Cortex-M3 devices – Luminary Micro , STMicroelectroncs, NXP

Технология отладки и трассировки в CPU Cortex-M3, 

Расширяет возможности технологии EmbeddedICE для ARM7 и

ARM9.

SIMECS



32

Coresight – Serial Wire (SW) 

 2-проводной последовательный интерфейс

 Serial Data + Clock - заменяет интерфейс JTAG (5-проводной)

 Пропускная способность примерно такая же как у JTAG

 JTAG и SW используют одинаковый разъем JTAG 20-pin или 10-pin

 Добавляет новые возможности при отладке

 Доступ к памяти на лету во время исполнения программы

 Чтение памяти при работающем CPU

 Не требуется нового разъема, адаптера ил монитора для отладки

 8 аппаратных точек останова (EmbeddedICE для ARM7 & ARM9 - только 2 )

 Интегрированная технология трассировки ETM

Сокращает затраты на интерфейс (всего 2 контакта) и добавляет 

новые возможности к тем что предлагает стандартный JTAG!

SIMECS
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Трассировка данных (SWV)

 Полностью поддерживается в MDK-ARM

 Не требуется дополнительного аппаратного или программного 

обеспечения

 Serial Wire интерфейс поддерживается всеми адаптерами ULINK

SIMECS
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Coresight – Serial Wire Viewer (SWV)

 Real-Time Trace осуществляет:

 Чтение и запись значений выбранных переменных

 Счетчик событий, который показывает статистику циклов CPU

 Временная статистика исполнения программы или прерывания

 Опрос программного счетчика - локализация бесконечных циклов

Обеспечивает трассировку без дополнительных ПО и 

аппаратуры

SIMECS
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SWV – смотри как хочешь

SWV просто использовать и конфигурировать, данные 

обновляются в реальном времени, 3 различных варианта 

просмотра переменных. 

Memory Window – View > Memory Window

Watch Window – View > Watch and Call Stack Window

ITM Viewer – View > Serial Window > ITM Viewer

SIMECS
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Конфигурация трассировки

 Простая настройка

 Окно Cortex-Mx Target Driver Setup

 MDK-ARM отображает информацию о трассировке

 Четыре окна:

 Trace Records

 Трассировка прерываний

 Счетчик событий

 Логический анализатор

SIMECS
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Окно трассировки 

 Простая конфигурация

 Cortex-M Target Driver 
Setup window.

 Четыре вида 
трассировки:

 Записи трассировки

 Логический анализатор 

 Exceptions

 Counters

Различные типы Trace Data can be viewed in µVision’s

three Trace Windows and the Logic Analyzer.

SIMECS
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Trace Windows - Логический анализатор

Логический анализатор µVision отображает изменение значений 

во времени до четырех выбранных переменных

SIMECS



40

Трассировка прерываний

 Показывает:

 Название прерывания, номер, число вызовов

 Максимальное и минимальное время, затраченное на 

прерывание

 Первое и последнее время прерывания

SIMECS
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Счетчик событий

 В реальном времени показывает значения 

специализированных счетчиков 

 Дает возможность определить не только время, 

затраченное на исполнение программы, но и следующие 

характеристики:

 количество циклов ожидания (например, при медленной памяти);

 количество циклов простоя, 

связанных с ошибками CPU;

 время в спящем режиме;

 количество циклов загрузки 

и быстрых инструкций, которые 

ускоряют время выполнения 

приложения.

SIMECS
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Инструменты для отладки и 

трассировки
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 Новые свойства

 Отладка и трассировка Cortex-M3

 Plug and Play подключение USB

 Отладка на лету с Real-Time Agent

 Отладка программы 

 По шагам и в реальном времени

 Программные и Flash точки останова

 Memory Access Breakpoints

 Программирование Flash 

 Загрузка, верификация и исполнение

ULINK2 – адаптер USB / JTAG 

Простой в использовании USB адаптер, поддерживающий               

JTAG отладку и программирование Flash.
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Адаптер ULINK-ME

 ULINK-ME - дешевый адаптер для Starter Kit, поддерживает только 

ARM , имеет компактные размеры 28 x 80 мм, разъем 20pin

 Подключение

 Разъем Mini USB 

 USB 2.0 Full Speed (10 Mbps)

 Скорость загрузки Flash 28 KByte/s

 JTAG speed 30 MHz

 Отладка программы 

 Отладка и трассировка Cortex-Mx

 Max SWV capture 2Mbps (limited) 

 По шагам и в реальном времени

 Программные и Flash точки останова 
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ULINK Pro – адаптер USB / JTAG 

 Поддерживает Cortex-M3 трассировку ETM trace и 

осуществляет быструю загрузку Flash и режим

Serial-Wire Viewer.

 Существенно выше производительность
 USB 2.0 high speed (480Mbit/s)

 Standard WinUSB drivers

 Скорость загрузки Flash 600 KByte/s

 JTAG speed 50 MHz

 Cortex 4-bit ETM instruction trace
 Отладка сложных программ

 Поддержка Cortex Serial-Wire Viewer
 Полная поддержка трассировки данных                                                           

и команд при скорости 200Mbit/s 

 Цена EUR 900 + 18% НДС

SIMECS
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Преимущества ULINKPro

 Трассировка в реальном времени для устройств Cortex-M3

 Трассировка инструкций ETM дает полную информацию о выполнении 

кода

 Трассировка происходит без остановки выполнения основного 

приложения

 Повышает компактность кода

 Позволяет следить за выполнением программы в реальном времени

 Передача данных через интерфейс USB 2.0

 Позволяет проводить анализ плотности кода и производительности

 Поддержка устройств с частотой до 200MHz

 Поддержка различных разъемов

 Совместимость и гибкость

SIMECS
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Сравнение устройств отладки и трассировки

ULINK-ME ULINK2 ULINKPro J-Trace JTAGjet-

Trace

Технологии отладки

Интерфейс JTAG

Интерфейс SWD

Трассировка данных SWV

Трассировка ETM

Производительность

JTAG Clock

Чтение/запись в память

Поток данных

10MHz

25KB/s

1Mb/s

10MHz

25KB/s

1Mb/s

50MHz

1MB/s

100Mb/s

12MHz

720KB/s

30MHz

1MB/s

Инструменты анализа

Логический анализатор

Анализатор 

производительности

Анализ плотности кода

SIMECS
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Стартовые комплекты

SIMECS
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Отладочные платы с Cortex-M3 

 Toshiba TMPM330

 Очень дешевый starter kit

 Питание от USB 

 ETM трассировка команд и Serial-Wire Viewer 

 NXP LPC1700

 Ethernet 10/100 и USB Host/OTG

 Порты CAN и Serial

 Интерфейс Micro SD card 

 ST Microelectronics STM32E

 Интерфейс USB device interface

 Внешняя память

 ETM трассировка команд и SWV

SIMECS
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Стартовый комплект  MCB1760-UME

Различные конфигурации MCB1760 

(MCB1750) плюс USB JTAG адаптер

 MCB1760 Evaluation Board for NXP 

LPC1760 series (Cortex-M3)
 Ethernet 10/100 и USB Host/OTG

 Порты CAN и Serial

 Интерфейс Micro SD card

MCB1760 + ULINK-ME = Evaluation 

Board for LPC1760 + ULINK-ME Adapter 

 MCB1760 + ULINK2 = Evaluation Board 

for LPC1760 + ULINK2 Adapter 

SIMECS
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Требуется больше информации?

 Примеры приложений

 Примеры программ 

 База данных устройств

 Экспертная поддержка 

 Дискуссионный форум

Заказчики ежедневно используют www.keil.com для получения

примеров программ, последней технической информации и 

поддержки.

SIMECS

http://www.keil.com/

